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Click the link below to go to the Education pages of the Compulink Client Website. The ‘Hot Topics' 
tab has information for the CURRENT Advantage Software version on distribution. For lists of 
enhancements for PREVIOUS version builds, go to the ‘VRNs Prior Versions’ tab. Here you will find a 
list of links with version numbers and release dates. 
Education Page for Psych

The "KNOW BEFORE YOU GO" section includes important items for your office to review PRIOR TO 
UPDATING to this new version.  Look for screen, table and other changes that might affect your 
workflow.   X  Items with a red X are additional important items.

The date in red to the left of the Enhancement, indicates the date the item was added to or updated 
on this document.

Items marked (Request) were requested by clients, and satisfied with this update.

The topics in the Table of Contents contain links; click a topic to jump to that spot in the document. 
Some of the topics are generic, and may not contain enhancements at current time of publication.
If you would like to come back to the Table of Contents, click on the red page number at the bottom
right of the page.
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KNOW BEFORE YOU GO
 X (2/25/2021) Databases >Imagereview > New Table Created

• This new internal table was created to store Image information, but is NOT accessible or 
   visible to the user.
• What does this new table do for you?
          • By creating a record in this table, it allows ONE generic Worklist to be created to 
             manage all items that need to be reviewed, regardless if they are in the 
             ExamCommunication, ExamSurgery, ExamTest or ExamTreatment database; the 
             Worklist 'EHR Documents Requiring Review' was updated to use this new table.
          • When the Provider views the image AND applies a signature, the 'REVIEWED' date 
             will automatically be populated in this table, and the item will be removed from 
             the Worklist.
• The table contains the following fields:
          • IMAGEREVIEWUNIQUE = A unique number assigned to this record
          • ADDED = The date the record was added to the table
          • PARENTTBLUNIQUE = The unique number that identifies the parent table that the 
             image is attached to (ExamCommunication, ExamSurgery, ExamTest or 
             ExamTreatment)
          • PARENTUNIQUE = The unique number in that parent table that the image is 
             attached to (Example: the specific patient ExamTest record)
          • IMAGUNIQUE = The unique number assigned to the actual image in the record
          • REVIEWREQUIRED = Logical field to indicate if this record needs to be reviewed 
          • REVIEWED = Date field indicating the date that the record was reviewed
• A record is created in this table by one of the following methods:
          • From the InBox, use the 'Xfer > Exam Test/Treatment/Surgery' command to 
             transfer and attach a Fax to a patient Exam.
          • Import an image into the Exam, right click on it and select the NEW option 'Review
             Required'; this adds the record and populates the 'REVIEWREQUIRED' field.

 X (12/15/2020) Exam >2021 E&M Coding > 2021 Evaluation and Management 
Coding Guidelines

• On December 1, 2020, the 2021 Evaluation and Management Coding Guidelines related to
   Office or Other Outpatient Codes (99202-99215) and Prolonged Services code (99354, 
   99355, 99356, 99XXX) changes were finalized. 
• Compulink recommends that you review the 2021 AMA Code and Guideline Changes to 
   ensure you select the appropriate billing code based on your own valuation. 
• Federal and State laws require providers to maintain the records necessary to fully 
   disclose the extent of services, care, and supplies furnished to beneficiaries, as well as to 
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KNOW BEFORE YOU GO
   support claims billed. 
• Compulink's 2021 E&M Coding Logic is built into Version 12.4, and will automatically 
   activate when your current system date reaches 1/1/2021. (Request)
• When entering Exam records, the Exam date must be greater than 1/1/2021.
• For more information, see the following NEW area: 2021 Evaluation and Management.

 X (12/23/2020) Exam >Command (Utility) > Coding Logic > .NEW Option Added

• The NEW Option 'Coding Logic' has been added to the 'Utility' command.
• The 'Exam E/M Code Level Logic > Logic Pages' and 'Logic Sets' that were under the Main
   Menu Utility in previous versions, have been moved under this NEW option for easier 
   access when making changes.
• User will only have access to this if Login Rights Profile 'EHR Coding Logic' is set to Full.
• Select 'Coding Logic' to open what used to be 'Logic Sets'.
          • This table was updated with features for the NEW 2021 E&M Coding.
          • Legacy Methodology – This NEW field was added to distinguish existing Legacy 
             Coding Logic from new Coding Logic that was added for 2021.
                    • Upon update to Version 12.4, all existing records will be assigned a 'Y', and 
                       all new logic will be added with an 'N'.
                    • After updating, any NEW records added will default to 'N'.
• From the 'Coding Logic' table, click 'Components' at the top to open what used to be 
   'Logic Pages'.

 X (12/14/2020) Exam >Tabs > EDITED: All Tabs With POS or Place of Service in the
Header

• The 'POS' or 'Place of Service' field will now default to 'Office', but may be changed.
• This field is used for differentiating the new AMA 2021 Coding engine that is based upon 
   Place of Service being Office.

 X (11/4/2020) Look-up Tables >Financial > Global Periods > Automatic Table 
Update

• Access to the 'Global Periods' table was removed from the menu.
• Compulink will be obtaining this information directly from CMS, and automatically adding 
   it to the software upon update; the user will no longer need to manually maintain it.

 X (1/13/2021) Look-up Tables >General > Labs > List > Field(s) ADDED

• External – A 'Y' identifies this lab as an external lab outside of your practice.
          • This field is used in the NEW 2021 E&M Coding engine.
          • It is VERY important to go through the labs and identify which ones are external.

 X (12/21/2020) Patient >Command (Insurance) > Command (Add) > EDITED: 
Policy#

• Default – When adding a new Insurance, the 'Policy#' will no longer default to the SSN 
   after selecting the Insured party. (Request)
          • Most Insurance companies no longer use the SSN, so the field will remain blank for
             the user to input the patient's valid Policy# from their card.

• Medicare check – The number of characters check was updated for Medicare. 
          • If an ID with anything other than 11 characters is entered, when the record is 
             saved, the following message will appear: Medicare ID Length requirement is 11!

 X (12/14/2020) Utility >Exam E/M Code Level Logic > Utility Moved to Patient 
Exam Utility

• The 'Exam E/M Code Level Logic > Logic Pages' and 'Logic Sets' have been moved under 
   the 'Utility' command in the patient Exam for easier access when making changes.
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KNOW BEFORE YOU GO
• User will only have access to this if Login Rights Profile 'EHR Coding Logic' is set to Full.
• Under 'Utility', select 'Coding Logic' to open what used to be 'Logic Sets'.
• Once inside 'Coding Logic', click on 'Components' at the top to open what used to be 
   'Logic Pages'.

 X (12/10/2020) Utility >PracticeWatch Setup > Multi-Threading

• Multi-threading will allow the majority of tasks to run on their own thread, such that a 
   frozen task or task that can take many hours, does not hold up the other processes from 
   running. 
• This change is handled through the DLL that is delivered through a normal update; there 
   is no need to reinstall the service.
• Important item to be aware of:
          • If your practice has numerous tasks set up to run at the same time, you can 
             expect PracticeWatch to use more processing power, now that they run parallel, 
             instead of one waiting on the next to complete.

Hot Topics
 (3/2/2021) MACRA/MIPS >   Updated 2020 Performance Year Reporting 

Flexibilities

• Due to the continuing COVID-19 public health emergency (PHE), CMS has reopened and 
   extended the application period for the PY 2020 Extreme and Uncontrollable 
   Circumstances (EUC) Exception to Wednesday, March 31st, 2021, 8:00 p.m. Eastern.
• The EUC Exception is automatically applied to Eligible Clinicians reporting individually and 
   within groups who have not submitted any performance data for PY 2020. In addition, 
   ECs reporting individually who have submitted data for only 1 category, such as Quality 
   Measures collected via Medicare Part B Claims, do not need to apply. These entities will 
   receive an automatic neutral payment adjustment in 2022 for all unreported categories.
• Individuals, groups and virtual groups not eligible for the automatic exception can 
   complete an application for 1 or more performance categories, citing that they have been
   impacted by the COVID-19 pandemic.
• Note: You can't submit an application to override PY 2020 data that has been submitted. 
   Any data submitted for an individual, group or virtual group (before or after an 
   application has been approved) will be scored.
• Please review the QPP COVID-19 Response Fact Sheet for additional details, FAQs and 
   information specific to APMs.

 (1/13/2021) Patient > Print > Word Processing >   LibreOffice Transition

• LibreOffice is a “fork” of OpenOffice; they use the same engine and components.
• At this point, OpenOffice seems to only be getting security updates, whereas LibreOffice is
   evolving quickly.
• With this in mind, Compulink wants to bring users the best product that we can, so we 
   are now interfacing with both OpenOffice and LibreOffice. (Request)
          • Nothing is changing in the application, it just allows both to work, since they are 
             both iterations of OpenOffice.
          • As of Advantage Version 12.3.0.28, LibreOffice has been tested with the Compulink
             Advantage application.
• Is LibreOffice required?
          • Users do NOT have to transition to LibreOffice if they are using V12.3, but it is 
             suggested that they do it upon updating to V12.4.
          • V12.4 makes no changes to the OpenOffice capabilities, and moving to LibreOffice 
             is not required.
• Transitioning to LibreOffice

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
support@compulinkadvantage.com | www.compulinkadvantage.com              4



Hot Topics
          • Since they share components, if LibreOffice is installed without first removing 
             OpenOffice, Compulink will use whoever is the 'owner' of the component services; 
             generally this is the first product installed (OpenOffice).
          • If you would like to only run one product, please check with your practice Network 
             Administrator or IT Professional on how to uninstall OpenOffice and install 
             LibreOffice.
                    • You can download the LibreOffice Installer file from: 
                       https://www.libreoffice.org/download/download/
                    • There are usually 2 options, a beta version and an older version; download 
                       the older version to your desktop.
                    • Once installation is complete, launch LibreOffice to verify that there is no 
                       registration that needs to be done before using it in the Advantage software
                       for the first time.
• Future support 
          • There may come a point when Compulink can no longer support the original 
             OpenOffice; if they stop security updates and we have no choice.

• Workstation Configuration
          • If you are going to use both OpenOffice and LibreOffice, or just LibreOffice, you 
             must update the Workstation Configuration.
          • This may need to be completed by you practice Administrator or IT Professional.
          • From the Patient Demographics, click the Printer & Output Tools icon on the 
             bottom right of the screen and select 'Workstation Configuration'.
          • Click 'Edit'.
          • Go to the 'Default Word Processor' field and select 'OpenOffice and LibreOffice'.

 (1/20/2021) Utility > PracticeWatch Setup >   NEW Auto-Collection Function

• The Advantage software now offers an Auto-Collection function that is automatically 
   generated and run through PracticeWatch.
• System Setup (Acct Billing tab > Statement section)
          • Auto Collection Charge Days
                    • The number of days old a charge (with a balance) must be, before it 
                       becomes eligible for the Auto-Collection function.
                    • Default is set to '0', meaning Not in Operation.
          • Auto Collection Last Payment Days
                    • The number of days since the last Responsible payment was made on the 
                       charge, before it is eligible for the Auto-Collection function.
                    • Default is set to '0', meaning Not in Operation.
• Patient Ledger
          • When PracticeWatch is run, it will look at the 2 fields in the System Setup to 
             determine which charges on the Ledger are eligible for Collection.
          • If the Sum Total for all eligible charges is a minimum of $25, then they become 
             eligible for the Auto-Collection function.
          • A Collection Record will automatically be generated on the account, and the Ledger
             Detail will be added.
          • The Demographic screen will also be flagged as being on Collection.
• Frequency – This new function runs once daily through PracticeWatch.

2021 Evaluation and Management
 X (12/15/2020) 2021 E&M > 1. Learn About the New Coding Guidelines

• CPT® Evaluation and Management (E/M) Office or Other Outpatient (99202-99215) and 
   Prolonged Services (99354, 99355, 99356, 99XXX) Code and Guideline Changes: 
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2021 Evaluation and Management
https://www.ama-assn.org/system/files/2019-06/cpt-office-prolonged-svs-code-
changes.pdf

• CPT E/M Office Revisions Level of Medical Decision Making (MDM): https://lms.compulink-
software.com/lms/materials/AdvantageProducts/1ALLPRODUCTS/2021E&MCodes_ServiceTa
bleUpdateInstructions.pdf

• Attend Compulink’s live training webinar “2021 E&M Coding Changes” (click on the 
   Education icon in your software and select ‘Live Training Webinars’)

 X (12/28/2020) 2021 E&M > 2. Code Selection (MDM or Time)

• In 2021, physicians will choose whether their documentation is based on Medical 
   Decision Making (MDM) or Total Time. 
• This builds on the initiative to better recognize the work involved in non-face-to-face 
   services like care coordination. 
• E&M code selection will be based on one of the following:
          • The level of Medical Decision Making (MDM) 
          OR 
          • The time performing the service on the day of the encounter

 X (12/15/2020) 2021 E&M > 3. Coding Recommendations

• Compulink provides coding recommendations based on programming algorithms 
   embedded in the Advantage program. 
          • These calculations are designed to assist the medical provider in selecting a billing 
             code. 
          • The provider must ensure that medical record documentation supports the level of 
             service reported to a payer. 
• Advantage Version 12.4 coding recommendations support the 2021 Guidelines for Medical
   Decision Making, and Total Time spent with the patient.
• As always, Compulink recommends that practitioners select codes that best represent the 
   services furnished during the visit.
• It is imperative that the provider must ensure the submitted claim accurately reflects the 
   services provided.
• CMS recommends a billing specialist or alternate source should review the provider’s 
   documented services before submitting the claim to a payer.

 X (12/15/2020) 2021 E&M > 4. Prepare Your Advantage Software

• Update your Service Fees Table for code changes and Medicare payment rates for (E/M) 
   services (Utility > Look-up Tables > Financial > Services).
          • Service Fees Table Update Instructions: Service Fees Table Update Instructions: 
             https://lms.compulink-software.com/lms/mp4/sdftab_105.mp4
          • Service Table Updates for 2021 E&M Code Changes: https://lms.compulink-
software.com/lms/materials/AdvantageProducts/1ALLPRODUCTS/2021E&MCodes_ServiceTa
bleUpdateInstructions.pdf
          • Code 99201(new patient, level 1) is being retired, effective 01/01/2021. Code 
             99211 for established patients is being retained.
          • 2 new G codes were added:
                    • G2211 – Complex Visit (associated with single, serious or complex 
                       condition)
                    • G2212 – Prolonged Services (in 15 min increments - the threshold where 
                       the visit becomes prolonged varies by new/established)

 X (1/20/2021) 2021 E&M > 5. Universal Exam Field(s) ADDED

• The fields listed below are universal fields added to the Advantage software.
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2021 Evaluation and Management
• The field labels on the screens are blue to indicate that they are used for E&M Coding.
• Universal fields added:
          • Diagnosis Change drop-down field
                    • New Diagnosis:
                              • When adding a new Diagnosis, this field will default to empty, so the 
                                 user should select a 'Change' from the drop-down.
                    • Forwarding a Diagnosis:
                              • When forwarding a single Diagnosis, a 'Select Problem Change' 
                                 window will open for you to select the 'Change' from.
                              • When forwarding multiple Diagnoses, if the field already has a value,
                                 it will forward that value; if the field is empty, it will default to 
                                 'Stable', but may be changed if needed.
                    • The E&M Coding engine will use this 'Change' field when coding out the 
                       level of Exam.
          • Diagnosis Severity drop-down field
                    • New Diagnosis:
                              • When adding a new Diagnosis, this field will default to the value 
                                 assigned to the code in the Diagnosis Name table, but may be 
                                 changed if needed.
                              • If the field is empty in the table, it will default to empty, and a 
                                 'Severity' should be selected from the drop-down.
                              • When adding a new Diagnosis via an Encounter Favorite, the 
                                 functionality will be the same as above.
                    • Forwarding a Diagnosis:
                              • If the field already has a value, it will forward that value.
                              • If the field is empty, it will be assigned the value from the Diagnosis 
                                 Name table with the same code.
                              • If both values are empty, it will default to empty, and a 'Severity' 
                                 should be selected from the drop-down.
                    • The E&M Coding engine will use this 'Severity' field when coding out the 
                       level of Exam.
          • High Risk check box field
                    • Populate for any Health History item that is High Risk for a Treatment or 
                       Surgery.
                    • Any item marked as 'High Risk' will display in red text in the grid.
                    • High Risk comes into play only if a Procedure is ordered that would be High 
                       Risk for a specific patient (due to many factors such as illness or social 
                       determinants).
                              • If Health History items are checked, when a Treatment or Surgery is 
                                 added and the 'Name' or 'Procedure' is selected, a window will open 
                                 with all High Risk items selected during that encounter.
                              • If one of the items is High Risk for the Treatment/Surgery record 
                                 that is being displayed in the header of the window, double click on 
                                 that item; if not, hit the Escape key or click the 'X' to close the 
                                 window.
                              • If a High Risk item is selected, the 'Identify High Risk Reasons' 
                                 memo field will open, and the item selected will default into the data
                                 area for additional documentation.
                              • Save the window and the additional documentation will display in the
                                 'High Risk' Notes field for reference.
                    • Checking the 'High Risk' box alone does not count for documentation, it 
                       must be connected to either a Treatment or Surgery (if applicable) with 
                       additional explanation added for calculation.
          • High Risk memo field
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2021 Evaluation and Management
                    • This field is available in the Surgery and Treatment areas.
                    • The Provider may enter necessary High Risk notes for auditing purposes.
                    • Double click in the field to select from default items.
                    • Right click in the field and select 'View Lookup List Entries' to open the 
                       'High Risk Note' Virtual Look-up Table.
          • Historian memo field
                    • User documents if data was provided by anyone other than the patient; 
                       they may also want to document the reason, like 'patient is non-verbal'.
                    • This is only used if the patient is not able to supply the information, such as
                       a child; an interpreter is NOT considered an Independent Historian, as the 
                       patient is still providing the information.
                    • Double click in the field to select from default items.
                    • Right click in the field and select 'View Lookup List Entries' to open the 
                       'Historian' Virtual Look-up Table.
                    • Coding logic is looking to see if the field is populated or not; it is not looking
                       for specific data in the field.
                    • This field can be found in the following Exam areas:
                              • Allergies
                              • Complaint 
                              • Health History
                              • Immunization
                              • Medication
                              • Review of Systems
                              • Surgery
                              • Test
                              • Treatment
          • Independent Interpretation check box field
                    • Populate for any Exam Test where the 'Findings' or 'Interpretation' was done
                       by the Provider on the date of the Exam.
                    • If the Provider only 'Reviewed' the information provided by another source, 
                       and did not interpret the Test themselves, then do NOT check the box.

 X (12/15/2020) 2021 E&M Coding > 2021 Evaluation and Management Coding 
Guidelines

• On December 1, 2020, the 2021 Evaluation and Management Coding Guidelines related to
   Office or Other Outpatient Codes (99202-99215) and Prolonged Services code (99354, 
   99355, 99356, 99XXX) changes were finalized. 
• Compulink recommends that you review the 2021 AMA Code and Guideline Changes to 
   ensure you select the appropriate billing code based on your own valuation. 
• Federal and State laws require providers to maintain the records necessary to fully 
   disclose the extent of services, care, and supplies furnished to beneficiaries, as well as to 
   support claims billed. 
• Compulink's 2021 E&M Coding Logic is built into Version 12.4, and will automatically 
   activate when your current system date reaches 1/1/2021. (Request)
• When entering Exam records, the Exam date must be greater than 1/1/2021.
• For more information, see the following NEW area: 2021 Evaluation and Management.

 X (12/28/2020) 2021 E&M Coding > Code Level Determination > .Total Time

• E&M code selection will be based on the time performing the service on the day of the 
   encounter, if the E&M is not already maxed out.
          • Location – New Patient check box OR Visit Type field (product specific)
                    • Workflow – Depending on your Advantage product, various exam tabs will 
                       contain either a 'New Patient' check box or a 'Visit Type' field.
                              • Check box – If the patient is new to the office, check the box; if not, 
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2021 Evaluation and Management
                                 leave the box empty, and if there is another appropriate box, check 
                                 that one.
                              • Field – If the patient is new to the office, select 'New', if not, you 
                                 may select 'Established' or another appropriate option. 
                                        • A Smart Function is attached to the field to automatically 
                                           check an INTERNAL check box.
                    • Determination – Coding Logic will look for the 'New Patient' check box to be 
                       either checked or unchecked (this also looks at the INTERNAL check box).
          • Location – 'Total' time field on various tabs.
                    • Workflow – When adding a new layout, the 'Start' time will default. The 
                       user may enter the 'End' time and tab out of the field for the software to 
                       calculate the 'Total' time, or manually enter the 'Total' time.
                    • Determination – Coding Logic looks at the value in the 'Total' time field.

• Code Level Determination for New Patient:
          • Coding Logic will look for these items for ALL levels:
                    • Exam Time greater than 0
                    • E&M Code Level less than 4
                    • New Patient field is checked
          • Code Levels
                    • Level 1 = Exam Time greater than 15
                    • Level 2 = Exam Time greater than 30
                    • Level 3 = Exam Time greater than 45
                    • Level 4 = Exam Time greater than 60
• Code Level Determination for Established Patient:
          • Coding Logic will look for these items for ALL levels:
                    • Exam Time greater than 0
                    • E&M Code Level less than 4
                    • New Patient field is NOT checked
          • Code Levels
                    • Level 1 = Exam Time greater than 10
                    • Level 2 = Exam Time greater than 20
                    • Level 3 = Exam Time greater than 30
                    • Level 4 = Exam Time greater than 40

 X (12/28/2020) 2021 E&M Coding > Code Level Determination > Medical Decision 
Making (MDM)

• E&M code selection will be based on the level of Medical Decision Making (MDM).
• Code Level Determination:
          • To determine Code Level, replace the letter 'X' below with the Level # that you are 
             trying to determine.
          • Level X
                    • Problem Level is >= X AND Data Count Level is >= X
                       OR
                    • Problem Level >=X AND Management Level >=X
                       OR
                    • Data Count Level >= X AND Management Level >=X
          • EXAMPLE: Level 1
                    • Problem Level is >= 1 AND Data Count Level is >= 1
                       OR
                    • Problem Level >=1 AND Management Level >=1
                       OR
                    • Data Count Level >= 1 AND Management Level >=1
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2021 Evaluation and Management
 X (1/14/2021) 2021 E&M Coding > Data Count Determination

• Definitions
          • DiscussionNotes
                    • This must be an actual 'conversation' with the external source via phone, 
                       text or E-mail on the same date as the Exam.
                    • Location – Exam Communication 
                    • Workflow – Import Communications from an outside source into the 
                       Communications tab.
                              • Once imported, right click on the image and select 'View Full 
                                 Screen' to attach the Provider signature.
                              • Prior to saving the record, verify that it has been marked 'Reviewed'.
                    • Determination
                              • Coding Logic is looking for a Communication record with a 
                                 'Reviewed' date equal to the Exam date.
                              • It is also looking for one of the following in the 'Contact Type':
                                        • Case Manager
                                        • Lawyer
                                        • Parole Officer
                                        • Provider
                                        • Referral
                                        • Teacher
          • External Lab – A Lab that has the 'External' field set to 'Y' under 'Utility > Look-up 
             Tables > General > Labs > List'.
          • ExtTestsOrdered
                    • Location – EHR Tests (Lab Tests Ordered)
                    • Workflow – Add appropriate EHR (Lab) Tests (selecting from the drop-
                        down).
                    • Determination
                              • Coding Logic is looking for the number of EHR Tests with 'Ordered' 
                                 dates, and an External Lab.
          • ExtTestsReviewed
                    • Location – EHR Tests (Lab Tests)
                    • Workflow – Edit appropriate EHR (Lab) Tests, review information and mark 
                       'Reviewed'.
                    • Determination
                              • Coding Logic is looking for the number of EHR Tests with 'Reviewed' 
                                 dates equal to the Exam date, and an External Lab.
          • ExtTestsInterpreted
                    • Location – EHR Tests (Lab Tests)
                    • Workflow – Edit appropriate EHR (Lab) Tests, review information, enter 
                       'Findings' or 'Interpretation' (product specific), mark 'Reviewed' and mark 
                       'Independent Interpretation'.
                    • Determination
                              • Coding Logic is looking for the number of EHR Tests with information 
                                 in the 'Findings' or 'Interpretation' field, 'Reviewed' dates, 
                                 'Independent Interpretation' checked and an External Lab.
          • HistorianComments
                    • Location – Historian field (multiple areas where historical information is 
                       being documented): Allergies, Complaint, Health History, Immunizations, 
                       Medications, Review of Systems, Surgeries, Tests and Treatments.
                    • Workflow – Document any of the items above. 
                              • In the 'Historian' field, enter the name of the person that provided 
                                 the data if anyone other than the patient.
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2021 Evaluation and Management
                              • You may also want to document the reason, like 'patient is non-
                                 verbal'.
                    • Determination
                              • Coding Logic is looking for the number of times the field is 
                                 populated; it is not looking for specific data in the field.
          • NotesReviewed
                    • This is a combination of the 2 Locations below.
                    • Location 1 – Exam CDA (Clinical Document Architecture or the human 
                       readable form of the CCD)
                              • Workflow – In Exam, click on MACRA > View Imported CCD.
                              • Determination – Coding Logic is looking for this to be reviewed.
                    • Location 2 – Exam Communication 
                              • Workflow – Import Communications from an outside source into the 
                                 Communications tab; the import can be done prior to the Exam, but 
                                 the review by the Provider MUST be done the same day as the 
                                 Exam.
                              • Mark for Review
                                        • This can be done prior to the date of the Exam.
                                        • Once imported, left click on the image and select 'Requires 
                                           Review'.
                                        • The 'Select Staff' window opens for you to select the person 
                                           responsible for reviewing the Communication record.
                                        • Save the record.
                              • Provider Review
                                        • This must be done the same day as the Exam.
                                        • Edit the Communication record, right click on the image and 
                                           select 'View Full Screen'.
                                        • Once open, a 'Sign' button at the top allows the Provider to 
                                           capture their signature with a date stamp on the image. 
                                           (Request)
                                        • This action shows the Provider “Reviewed prior external notes 
                                           from each unique source”.
                                        • Close the image and the 'Reviewed' date will be populated.
                              • Determination - Coding Logic is counting any instance of a CDA with 
                                 a Reviewed date equal to the Exam date, then adding to that count, 
                                 the number of Communication records with a Reviewed date equal 
                                 to the Exam date.

• Data Count Determination:
          • Level 1/Minimal or None
                    • No Data Count elements completed
          • Level 2/Limited
                    • The number of NotesReviewed, plus the number of ExtTestsReviewed 
                       plus the number of ExtTestsOrdered is greater than or equal to 2
                       OR 
                    • At least 1 HistorianComments
          • Level 3/Moderate
                    • The number of NotesReviewed, plus the number of ExtTestsReviewed, plus 
                       the number of ExtTestsOrdered plus at least 1 HistorianComments is 
                       greater than or equal to 3
                       OR 
                    • At least 1 DiscussionNotes
                       OR 
                    • At least 1 ExtTestsInterpreted
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2021 Evaluation and Management
          • Level 4/Extensive
                    • At least 1 DiscussionNotes AND at least 1 ExtTestsInterpreted
                    • The number of NotesReviewed, plus the number of ExtTestsReviewed, plus 
                       the number of ExtTestsOrdered plus at least 1 HistorianComments is
                       greater than or equal to 3 
                       AND 
                    • At least 1 DiscussionNotes OR at least 1 ExtTestsInterpreted

 X (12/28/2020) 2021 E&M Coding > Emergency Determination

• Location – Diagnosis
          • Workflow – Add a Diagnosis(es) for the patient's current condition, and verify that 
             the 'Severity' and 'Change' fields are populated correctly.
          • Determination – Coding Logic is looking for the 'Severity' to be 'Urgent/Emergent'.

 X (2/18/2021) 2021 E&M Coding > High Risk Determination

• High Risk comes into play if a Procedure or Treatment is ordered that would be High Risk 
   for a specific patient (due to many factors, such as illness or social determinants).
           • Example: Social History of 'Homeless' may prevent the patient from access to 
              proper post-op care or medications.
• Location – Health History
          • Workflow:
                    • Check the 'High Risk' field for any Health History item that is High Risk for 
                        a Treatment or Surgery.
                    • The Description of items marked as 'High Risk' will display in red in the 
                        grid.
          • Determination – No direct determination, but connects to entering data for 
             Surgeries and Treatments.
• Location – Surgeries and Treatments
          • Workflow:
                    • Add appropriate Surgery or Treatment records.
                    • If Health History items are checked, when a Treatment or Surgery is added 
                       and the 'Name' or 'Procedure' is selected, a window will open with all High 
                       Risk items selected during that encounter.
                    • If one of the items is High Risk for the Treatment/Surgery record that is 
                       being displayed in the header of the window, double click on that item; if 
                       not, hit the Escape key or click the 'X' to close the window.
                    • If a High Risk item is selected, the 'Identify High Risk Reasons' memo field 
                       will open, and the item selected will default into the data area for 
                       additional documentation; example, the reason this is High Risk.
                    • Save the window and the additional documentation will display in the 'High 
                       Risk' Notes field for reference.
          • Determination:
                    • Coding Logic is looking for the 'High Risk' memo field to be populated; it is 
                       not looking for specific data in the field.
                    • It is looking at the Surgery and Treatment records with the 'High Risk' 
                       memo field documented, to also have a 'Performed' date equal to the Exam
                       date.
• Location – Next Appointments
          • Workflow - Add a suggested follow-up visit for the patient's current condition.
                    • If the 'Target' date is equal to the Exam date, or the following day, the text 
                       will display red in the grid.
          • Determination – If there are no 'High Risk' Surgery or Treatments flagged, the 
             coding Logic will look for the Next Appointment 'Target' date field to be equal to 
             the current Exam date, OR the following day.
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2021 Evaluation and Management

• High Risk Determination:
          • At least 1 or more High Risk Service (A Service or Treatment entered with the 
             'Performed' date equal to the Exam date, and data in the 'High Risk' memo field).
             OR 
          • The Next Appointment 'Target' date field to be equal to the current Exam date, OR 
             the following day.

 X (1/8/2021) 2021 E&M Coding > Management Level Determination

• Management Level Determination is based upon several items.
• Location – Medications
          • Workflow – Add Medications appropriate to the Treatment Plan for the patient's 
             condition.
          • Determination:
                    • Coding Logic is only looking at Medication records with the 'Historical' field 
                       unchecked.
                    • It then looks at other identifying factors of the Medication to determine if it 
                       is an over the counter or prescribed Medication.
• Location – EHR Orders
          • Workflow – Add EHR Orders appropriate to the Treatment Plan for the patient's 
             condition.
          • Determination – Coding Logic is counting the specific criteria below to determine 
             the complexity of the Management Level of the Orders.
                    • Coding Logic Component: Non-Drug Rx Prescribed
                              • Order Name = Referral to emergency clinic
                              • Order Name = Referral to PCP Diabetic Screening Exam
                    • Coding Logic Component: Non-Drug Rx Prescribed OTC
                              • Order Name = Fiber Supplement
                              • Order Name = Multi-Vitamin
                              • Order Name = NSAIDS
                              • Order Name = Sleep Aids
                              • Order Name = Vitamin D
                    • Coding Logic Component: SELF-CARE
                              • Order Name = Light Therapy
                    • Coding Logic Component: UNKNOWN
                              • Visit Type = Consultation

• Additional Information:
          • Medication record or EHR Orders
                    • The Coding Logic will first look to see if there is a qualifying Medication 
                       record for the Exam date, if it doesn't find one, it will then look to the EHR 
                       Orders, and the criteria specified per Advantage product..
          • Items below are “Where applicable” based upon your Advantage product:
                    • CPT on Surgery for Global Period to determine Surgery level (if applicable).
                              • If Global period is 0-10 days, then Minor Surgery.
                              • If 11 days or greater, then Major Surgery.
                    • Place of Service determination (Hospital options).
                    • Emergency determination.

• Management Level Determination:
          • Level 1/Minimal
                    • No Management Level elements completed
          • Level 2/Low
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2021 Evaluation and Management
                    • Over the Counter Medication entered or EHR Order entered with criteria 
                       equal to Component: Non-Drug Rx Prescribed OTC
                       OR 
                    • EHR Order entered with criteria equal to Component: SELF-CARE
                       OR 
                    • Minor Surgery (based on Global Period)
          • Level 3/Moderate
                    • Medication prescribed or EHR Order entered with criteria equal to 
                       Component: Non-Drug Rx Prescribed 
                       OR 
                    • EHR Order entered with criteria equal to Component: UNKNOWN
                       OR 
                    • Major Surgery 
                       OR 
                    • Minor Surgery AND High Risk memo field documented
          • Level 4/High
                    • (Medication prescribed AND High Risk memo field documented) or (EHR 
                       Order entered with criteria equal to Component: Non-Drug Rx Prescribed 
                       AND High Risk memo field documented)
                    • Place of Service = Inpatient Hospital, Outpatient Hospital or Emergency 
                       Room-Hospital
                       OR 
                    • Emergency (Diagnosis Severity=Urgent/Emergent)
                       OR
                    • Major Surgery AND High Risk memo field documented

 X (12/28/2020) 2021 E&M Coding > Place of Service Determination

• Location – The 'POS' or 'Place of Service' field at the top of some Exam tabs.
          • Workflow – This will default to 'Office', but may be changed.
          • Determination: Coding Logic will look for one of the options below for Hospital
                    • Inpatient Hospital
                    • Outpatient Hospital
                    • Emergency Room-Hospital

 X (1/8/2021) 2021 E&M Coding > Problem Level Determination

• Location – Diagnosis
          • Workflow – Add a Diagnosis(es) for the patient's current condition, and verify that 
             the 'Severity' and 'Change' fields are populated correctly.
          • Determination – Coding Logic looks at the combination of the fields to determine 
             Problem Level.
                     • If the 'Severity' field is left blank on the patient Diagnosis record, it will be
                        read as 'None' when doing the Problem Level Determination.
                     • If the 'Change' field is left blank on the patient Diagnosis record, this will 
                        be read as 'Stable' when doing the Problem Level Determination.

• Problem Level Determination:
          • Problem Level 1/Minimal is equal to the following:
                     • 1 Diagnosis with (Severity=Mild) AND ((Change=Stable) OR 
                        (Change=Improved))
          • Problem Level 2/Low is equal to the following:
                     • 2 or more Diagnoses with (Severity=Mild) AND ((Change=Stable) OR 
                        (Change=Improved))
                     • 1 or more Diagnosis with ((Severity=None) or (Severity=0)) AND 
                        ((Change=Stable) OR (Change=Improved))
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2021 Evaluation and Management
                     • 1 or more Diagnosis with (Severity=Mild) AND ((Change=New) OR 
                        (Change=Worse))
                     • 1 Diagnosis with (Severity=Serious) AND ((Change=Stable) OR 
                        (Change=Improved))
          • Problem Level 3/Moderate is equal to the following:
                     • 2 or more Diagnoses with (Severity=Serious) AND ((Change=Stable) OR 
                        (Change=Improved))
                     • 1 or more Diagnosis with (Severity=Unknown) AND ((Change=New) OR 
                        (Change=Worse))
                     • 1 or more Diagnosis with (Severity=Serious) AND ((Change=New) OR 
                        (Change=Worse))
          • Problem Level 4/High is equal to the following:
                     • 1 or more Diagnosis with (Severity=Urgent/Emergent) AND 
                        ((Change=New) OR (Change=Worse))

 X (12/28/2020) 2021 E&M Coding > Time Based Coding

• Per the AMA, physician/other qualified health care professional time includes the following
   activities, when performed:
          • Preparing to see the patient (eg, review of tests)
          • Obtaining and/or reviewing separately obtained history
          • Performing a medically appropriate examination and/or evaluation
          • Counseling and educating the patient/family/caregiver
          • Ordering medications, tests, or procedures
          • Referring and communicating with other health care professionals (when not 
             separately reported)
          • Documenting clinical information in the electronic or other health record
          • Independently interpreting results (not separately reported) and communicating 
             results to the patient/family/caregiver
          • Care coordination (not separately reported)
• If using Time Based Coding, you will document Total Time for the provider for this 
   encounter, per the 2021 Guidelines.
          • The Total Time corresponding to CPT® codes 99202-99215 is defined in specific 
             intervals. 
                    • For example, in order to report 99215, 40-54 minutes of total time must be 
                       spent on the date of the encounter.
                    • Start and End dates not required.
          • G2212 – 15-minute increment add on code will also be attached when time 
             extends beyond limits for level 5 (i.e. 99205/99215).
• Note: If the exam documentation codes at a higher level than Time, then the coding will 
   default to the level suggested by Medical Decision Making.

Appointment

Appointment > Commands
 (11/10/2020) Command (Book/Edit) >   Episode Default

• The 'Episode' field will no longer default UNLESS, the patient that you are scheduling the 
   Appointment for is the current Patient Demographic screen that is also loaded, AND there
   is already an ACTIVE Episode selected on that screen. (Request)
• That active Episode will default into the field, and may be changed if needed.

 (1/27/2021) Command (Next) >   No Template Scheduled for Provider

• When viewing the Daily Detail for Provider 'ABC', if you click 'Next' and there is no 
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Appointment > Commands
   template scheduled for that Provider on the next day, the Detail will show blank, and the 
   Provider ID will stay as 'ABC'. (Request) 
• In previous versions, if there was no template assigned, the Provider ID would change to 
   one that had a template assigned that day.

 (1/20/2021) Command (Print) > Office at a Glance >   Status Added

• The 'Office at a Glance' report will now merge the Appointment 'Status'. (Request) 
• A new 'Status' column was added to the header to the right of 'Reason'.

 (12/23/2020) Command (Search) >   Multi-Resource Scheduling

• When booking a Multiple Resource Appointment, the duration of each segment will be 
   accounted for on the templates.
• If the Appointment lasts 30 min, and is scheduled on a template made up of 15 in 
   increments, the first slot will display the Appointment, and the second slot will display 
   '---', to show the time as occupied.
• In previous versions, this only displayed on templates built with Categories, but now it 
   will also display on non-Category templates. (Request)

 (12/21/2020) Command (Search) >   Save Goes to Schedule

• When booking an Appointment using the 'Search' command, once the user clicks 'Save', 
   they will be taken to the exact Schedule where the Appointment was saved, so they can 
   verify that it was made. (Request)

 (1/27/2021) Command (Utility) > Table Setup > Template Schedule >   No Exit 
Required

• After making a change to the Template Schedule, you no longer need to exit to the 
   patient, the change will take effect upon exit of the Template Scheduler.

Communication
 (1/20/2021) InBox > Command (Xfer) >   Exam Test/Treatment/Surgery

• The NEW option of 'Exam Test/Treatment/Surgery' was added.
• This allows the user to connect the Communication record to a patient's specific Test, 
   Treatment or Surgery record. (Request)
• Transfer the record:
          • Highlight the Communication record to transfer.
          • Highlight 'Xfer' and select 'Exam Test/Treatment/Surgery'.
          • When the 'Select Patient' window opens search for and select the patient you want 
             to transfer the Communication to.
          • Click 'OK' or 'Cancel' on the message: Press OK to Confirm Assignment to: *** 
             (*** will display the patient's name that was selected).
          • A 'Select Provider' window will open to allow you to connect a Provider to the 
             Communication record; double click to select.
          • If there is a Cover Page, click 'Yes' or 'No' on the message: Select YES to remove 
             the Cover Page Before Transferring?
          • A 'Select Test/Treatment/Surgery to Attach Document' window will open; double 
             click to select the record that you would like to connect the Communication to.
          • The Select window closes, and the Communication is removed from the Inbox.
          • Go to the patient Exam and find the Test/Treatment/Surgery that the 
             Communication was connected to.
                    • If the main tab contains an image field, the Communication will display in 
                       that field when the record is highlighted.
                    • If no image field, double click to edit the record and view the image.
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Communication
• ImageReview record
          • After transfer, a record is created in the NEW ImageReview table.
          • This is an INTERNAL table that is NOT visible to the user.
          • By creating a record in this table, it allows ONE generic Worklist to be created to 
             manage all items that need to be reviewed, regardless if they are in the 
             ExamCommunication, ExamSurgery, ExamTest or ExamTreatment database.

 (3/3/2021) Patient Portal > Validation >   Enter Birth Date

• On the Patient Portal site 'MySecureHealthData.com', the Validation process was updated 
   to only prompt for the patient Birth Date to be entered one time. (Request)

COVID-19
 X (1/4/2021) Exam > Diagnosis Codes > New for 2021

• In response to the national emergency that was declared concerning the COVID-19 
   outbreak, the Centers for Disease Control and Prevention’s (CDC) National Center for 
   Health Statistics (NCHS) is implementing six new Diagnosis codes into the International 
   Classification of Diseases, Tenth Revision, Clinical Modification (ICD-10-CM), effective 
   January 1, 2021.
• The FY 2021 ICD-10-CM code files, updated FY 2021 ICD-10-CM Coding Guidelines, and 
   additional information on the ICD-10-CM COVID-19 updates effective with discharges on 
   and after January 1, 2021 are now available in the Downloads section at: 
   https://www.cms.gov/medicare/icd-10/2021-icd-10-cm.

 X (1/4/2021) Exam > Procedure Codes > New for 2021

• The Centers for Medicare & Medicaid Services (CMS) is implementing 21 new Procedure 
   codes to describe the introduction or infusion of therapeutics, including monoclonal 
   antibodies and vaccines for COVID-19 treatment, into the International Classification of 
   Diseases, Tenth Revision, Procedure Coding System (ICD-10-PCS), effective January 01, 
   2021.
• The FY 2021 ICD-10-PCS code files and information on the ICD-10-PCS COVID-19 
   updates effective with discharges on and after January 1, 2021 are available in the 
   Downloads section at: https://www.cms.gov/medicare/icd-10/2021-icd-10-pcs.

Customization
 (1/13/2021) Designing Custom Crystal Reports > Adding Reports to the Menu

• To place custom reports on the Advantage report menu, you must enter the correct value 
   in the 'Subject' field on the Document Properties window.
• The topic in the Advantage Online Help Manual has been updated with the current list of 
   values that can be used. (Request) 
• Search for topic: Adding Reports to the Advantage Menu

 (3/3/2021) Screen Builder > ALL > Grid Options Removed

• The options for adding a cbsdbgrid and a cbsdbfiltergrid have been removed.
• The remaining sqlgrid option allows more functionality and flexibility in customization.
• By removing these 2 grid options, it also provides a performance boost to the software.

 (3/1/2021) Screen Builder > Examination > EDITED: All Layouts

• The New layout option 'Auto Communication' was added under the 'Height' field.
• Upon update, this field will default to True/checked for all Compulink-Owned layouts.
• If checked, it allows Auto Communications to be sent to Patient Contacts and Referral 
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Customization
   Sources under the following conditions:
          • This layout is used for the Exam, and is signed off on by the Provider.
          • The Patient Contact has the field 'Auto Communicate' checked and/or the Referral 
             Source has the 'Auto' field checked.
• If unchecked, and this layout is used in the Exam, no Auto Communications will be sent.
          • An example may be for a Communication or Med-Check type layout.
• Once the permission to send the communication has been established, it will then choose 
   the appropriate document based upon normal procedure.
          • The letter established in the Contact/Referral record, or the document assigned in 
             the 'Complete Doc' field in the layout options.

 (1/20/2021) Smart Function Editor > ALL > EDITED: GetField

• The GetField Smart Function was updated to check to see if the table is in Edit mode; if 
   not, it will put it in Edit mode before completing the Function.

Data Mining
 (1/27/2021) Criteria > Birthday Criteria Update

• The monthly birthday criteria were updated to ONLY look for Active patients. (Request)

Databases
 X (2/25/2021) Imagereview > New Table Created

• This new internal table was created to store Image information, but is NOT accessible or 
   visible to the user.
• What does this new table do for you?
          • By creating a record in this table, it allows ONE generic Worklist to be created to 
             manage all items that need to be reviewed, regardless if they are in the 
             ExamCommunication, ExamSurgery, ExamTest or ExamTreatment database; the 
             Worklist 'EHR Documents Requiring Review' was updated to use this new table.
          • When the Provider views the image AND applies a signature, the 'REVIEWED' date 
             will automatically be populated in this table, and the item will be removed from 
             the Worklist.
• The table contains the following fields:
          • IMAGEREVIEWUNIQUE = A unique number assigned to this record
          • ADDED = The date the record was added to the table
          • PARENTTBLUNIQUE = The unique number that identifies the parent table that the 
             image is attached to (ExamCommunication, ExamSurgery, ExamTest or 
             ExamTreatment)
          • PARENTUNIQUE = The unique number in that parent table that the image is 
             attached to (Example: the specific patient ExamTest record)
          • IMAGUNIQUE = The unique number assigned to the actual image in the record
          • REVIEWREQUIRED = Logical field to indicate if this record needs to be reviewed 
          • REVIEWED = Date field indicating the date that the record was reviewed
• A record is created in this table by one of the following methods:
          • From the InBox, use the 'Xfer > Exam Test/Treatment/Surgery' command to 
             transfer and attach a Fax to a patient Exam.
          • Import an image into the Exam, right click on it and select the NEW option 'Review
             Required'; this adds the record and populates the 'REVIEWREQUIRED' field.

Exam
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Exam > General Changes
 (1/15/2021) General > Adding Signature to PDF Updated

• When adding a signature to a document in the PDF Viewer, you can now double click in 
   the exact spot where you need the signature to merge on the document. (Request) 
• This will save time in having to drag it from where it appears, to where it needs merge on
   the document.

 (1/15/2021) General > Print Smart Function Updated

• When printing a letter with a Sign option via a Smart Function, it will now be saved to 
   EHR Documents, the same as if printing from the 'Print > Letter' command. (Request)

Exam > Commands

Exam > Command (Add)
 (1/12/2021) Command (Add) > Legacy Health History Information

• When adding a new exam and clicking on the Health History tab, the user will no longer 
   be presented with the message: Select YES to forward legacy PFSH items into New 
   Health History format!
• Completing a specified number of Health History items is no longer required for 2021 E&M
   Coding.

Exam > Command (E-Rx)
 (1/12/2021) Command (E-Rx) > Monitor > Registration Message

• When clicking on the 'Monitor' command, if the Provider is not already registered with 
   Appriss, the following message will display: Please Register with Appriss Healthcare and 
   then enter your Username and Password from Utility Menu!

 (3/17/2021) Command (E-Rx) > Refill > No Matching NDC

• If a Refill Request comes through, and the NDC code is NOT found in the Medication table,
   the following message will appear: This Refill Request contains invalid drug information 
   and MUST be processed as Denied New to Follow.
• The user will need to process the Request with the 'Denied New to Follow', and submit 
   with a Medication that has the correct NDC code.

Exam > Command (Fees)
 (12/21/2020) Command (Fees) > Charges >   Tests Performed

• Tests added to the Exam will NOT display in the 'EHR Automated Fee Posting' window for 
   charging out to the Ledger unless there is a 'Performed' date. (Request)

 (11/4/2020) Command (Fees) > EHR Auto Fee Posting Window >   Options Saved 
for Ledger Posting

• If a user makes changes in the 'EHR Automated Fee Posting' window, and then selects the
   'Save for Ledger Posting' button, those changes will be saved and remembered when 
   clicking the 'EHR Post' command at the Ledger.
• Example: The 'Diagnosis', 'Provider ID', 'Aux. ID' and 'Dept' are all assigned in the 
   window, and the button is selected. When the user goes to the Ledger and clicks 'EHR 
   Post', all of those same assignments will be displayed.

 X (4/28/2021) Command (Fees) > Fee Group Rules >   ADDED: See Below

• The following items were added to support 2021 E&M Coding:

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
support@compulinkadvantage.com | www.compulinkadvantage.com              19



Exam > Command (Fees)
          • Prolonged Service G2212 EP 69-83 Min
          • Prolonged Service G2212 EP 84-98 Min
          • Prolonged Service G2212 EP 99-113 Min
          • Prolonged Service G2212 NP 89-103 Min
          • Prolonged Service G2212 NP 104-118 Min
          • Prolonged Service G2212 NP 119-133 Min

 (4/28/2021) Command (Fees) > Fee Posting Groups >   ADDED: Prolonged 
Services

• The following item was added to support 2021 E&M Coding:
          • Prolonged Services – Post Group Detail 'G2212'

Exam > Command (Orders)
 (12/21/2020) Command (Orders) > Diagnoses Window > ADDED: Diagnosis 

Severity

• The Diagnosis grid at the top now displays the NEW 'Severity' field.

Exam > Command (Utility)
 X (12/23/2020) Command (Utility) > Coding Logic > .NEW Option Added

• The NEW Option 'Coding Logic' has been added to the 'Utility' command.
• The 'Exam E/M Code Level Logic > Logic Pages' and 'Logic Sets' that were under the Main
   Menu Utility in previous versions, have been moved under this NEW option for easier 
   access when making changes.
• User will only have access to this if Login Rights Profile 'EHR Coding Logic' is set to Full.
• Select 'Coding Logic' to open what used to be 'Logic Sets'.
          • This table was updated with features for the NEW 2021 E&M Coding.
          • Legacy Methodology – This NEW field was added to distinguish existing Legacy 
             Coding Logic from new Coding Logic that was added for 2021.
                    • Upon update to Version 12.4, all existing records will be assigned a 'Y', and 
                       all new logic will be added with an 'N'.
                    • After updating, any NEW records added will default to 'N'.
• From the 'Coding Logic' table, click 'Components' at the top to open what used to be 
   'Logic Pages'.

 X (12/18/2020) Command (Utility) > Coding Logic > ADDED: See Below

• NEW entries were added for the following codes to support 2021 E&M Coding: (Request)
          • 99202
          • 99203
          • 99204
          • 99205
          • 99211
          • 99212
          • 99213
          • 99214
          • 99215

 (1/20/2021) Command (Utility) > Coding Logic > EDITED: OVERRIDE

• All 'OVERRIDE' items were changed to User-Owned, marked Hidden, and flagged as 
  'Legacy Methodology', as they are no longer needed with the new 2021 E&M Coding 
engine.

 X (12/18/2020) Command (Utility) > Coding Logic > Components > ADDED: See 
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Exam > Command (Utility)
Below

• The NEW entries below were added for the 2021 E&M Coding Engine:
          • Non-Drug Rx Prescribed
          • Non-Drug Rx Prescribed OTC
          • SELF-CARE

 (1/20/2021) Command (Utility) > Coding Logic > Components > EDITED: 
OVERRIDE

• All 'OVERRIDE' Components were changed to User-Owned and Hidden, as they are no 
   longer needed with the new 2021 E&M Coding engine.

 (1/7/2021) Command (Utility) > Coding Logic > Components > Name Already 
Exists

• When saving a Component, if the 'Name' already exists in the table, the following 
   message will appear: Name already exists!

 (1/20/2021) Command (Utility) > Coding Logic > Components > Table ADDED

• The 'Table' drop-down now has access to the following tables:
          • EXAMOBJTEST
          • EXAMORDER
          • EXAMSURG
          • EXAMTEST
          • EXAMTREATMENT

Exam > Layouts

Exam > Layouts (ADDED)
 (4/20/2021) Layouts >   ADDED: PopUpACEs

• Created to document the 'Adverse Childhood Experience (ACE) Questionnaire'. (Request) 
• It can be accessed by clicking on the TabAdd 'Assessment Tools' button, and then 
   selecting 'Adverse Childhood Experience (Ace) Questionnaire'.
• Contains only the NEW PopUpACEs tab.

 (4/20/2021) Layouts >   ADDED: PopUpAudit

• Created to document 'The Alcohol Use Disorders Identification Test: Interview Version'.
• It can be accessed by clicking on the TabAdd 'Assessment Tools' button, and then 
   selecting 'AUDIT (Alcohol Use Disorders Identification Test'.
• Contains only the NEW PopUpAudit tab.

 (4/20/2021) Layouts >   ADDED: PopUpCSSR

• Created to document the 'Columbia-Suicide Severity Rating Scale (C-SSR)'.
• It can be accessed by clicking on the TabAdd 'Assessment Tools' button, and then 
   selecting 'Columbia-Suicide Severity Rating Scale (C-SSR) Self-Report'.
• Contains only the NEW PopUpCSSR tab.

 (1/21/2021) Layouts >   ADDED: Scanned Records

• This layout was created for scanning in paper charts, and contains only the 'EHR 
   Documents' tab. (Request)

Exam > Tabs
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Exam > Tabs (ADDED)
 (4/20/2021) Tabs >   ADDED: PopUpACEs

• Created to document the 'Adverse Childhood Experience (ACE) Questionnaire'. (Request) 
• It can be accessed by clicking on the TabAdd 'Assessment Tools' button, and then 
   selecting 'Adverse Childhood Experience (Ace) Questionnaire'.
• Complete the Assessment and click the 'Calculate and Add to Assessment' icon to 
   calculate the 'Score'.
• Save the tab.
• Once back in the Exam, the following information will display in the 'Psychological 
   Assessments' grid:
          • Date – Exam date
          • Assessment - ACEs
          • Total – Score

 (4/20/2021) Tabs >   ADDED: PopUpAudit

• Created to document 'The Alcohol Use Disorders Identification Test: Interview Version'.
• It can be accessed by clicking on the TabAdd 'Assessment Tools' button, and then 
   selecting 'AUDIT (Alcohol Use Disorders Identification Test'.
• Complete the Assessment and click the 'Calculate and Add to Test Table' icon to calculate 
   the 'Total number of YES answers Score'.
• Save the tab.
• Once back in the Exam, the following information will display in the 'Psychological 
   Assessments' grid:
          • Date – Exam date
          • Assessment - Audit
          • Total – Score/Total number of YES answers

 (4/20/2021) Tabs >   ADDED: PopUpCSSR

• Created to document the 'Columbia-Suicide Severity Rating Scale (C-SSR)'.
• It can be accessed by clicking on the TabAdd 'Assessment Tools' button, and then 
   selecting 'Columbia-Suicide Severity Rating Scale (C-SSR) Self-Report'.
• Complete the Assessment and click the 'Calculate and Add to Assessment' icon to 
   calculate the 'Score'.
• Save the tab.
• Once back in the Exam, the following information will display in the 'Psychological 
   Assessments' grid:
          • Date – Exam date
          • Assessment - CSSR
          • CSSR – Score

 (4/28/2021) Tabs >   ADDED: TPMedications

• There are areas to document/view the following:
          • Medications
                    • A 'No Meds' tool icon is available for quickly adding a 'NONE REPORTED' 
                       record to the grid.
          • Aftercare Program (Document on Referral grid in Demographics)
          • Staff Who Entered Data/SignOff's

 (1/14/2021) Tabs >   ADDED: Tabs for Quality Measures

• MIPS CQMs, formerly called Registry Measures, may appear on the Exam Quality tab in 
   your Advantage product.
• These are a reminder for the provider to document information in the exam to support 
   the code(s).
• Unlike QMs collected via Medicare Part B claims, MIPS CQMs are not added to the 

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
support@compulinkadvantage.com | www.compulinkadvantage.com              22



Exam > Tabs (ADDED)
   Services table and do not post to the patient ledger.

Exam > Tabs (EDITED)
 X (12/21/2020) Tabs > EDITED: All PopUpDiag Tabs

• The following NEW fields were added:
          • Diagnosis Change drop-down field
                    • When adding a new Diagnosis, this field will default to 'New'.
                    • Forwarding a Diagnosis:
                              • When forwarding a single Diagnosis, a 'Select Problem Change' 
                                 window will open for you to select the 'Change' from.
                              • When forwarding multiple Diagnoses, this field will default to 'Stable',
                                 but may be changed if needed.
          • Diagnosis Severity drop-down field
                    • When adding a NEW Diagnosis, this field will default to the value assigned 
                       to the code in the Diagnosis Name table; if the field is empty, 'Mild' will 
                       default onto the record, but may be changed if needed.
                    • When FORWARDING a Diagnosis, this field will be assigned the value from 
                       the Diagnosis Name table with the same code; if the field is empty, 'Mild' 
                       will default onto the record, but may be changed if needed.

 (3/3/2021) Tabs > EDITED: All Tabs With Diagnosis

• The ellipsis hover menu options 'Forward' and 'Forward-Edit' were updated.
• When forwarding a Diagnosis from a previous visit, the order # will automatically re-order
   in the order that they are forwarded. (Request) 
• Example: 
          • R51.9 Headache unspecified (#3 Diagnosis on the previous visit)
          • If this is the first Diagnosis that you highlight and Forward to the current exam, it 
             will Forward with the Order #1.

 (4/20/2021) Tabs > EDITED: All Tabs With Diagnosis/Plan

• The following GridEdit options were updated on the ellipsis hover menu:
          • Intentional Self Harm Initial
          • Intentional Self Harm Subsequent
          • Intentional Self Harm Sequela
• After making a selection in the GridEdit window and saving the record, the following fields
   will default onto the record and display in the grid:
          • Severity = Defaults to 'Serious'
          • Change = Defaults to 'New'

 X (12/14/2020) Tabs > EDITED: All Tabs With POS or Place of Service in the Header

• The 'POS' or 'Place of Service' field will now default to 'Office', but may be changed.
• This field is used for differentiating the new AMA 2021 Coding engine that is based upon 
   Place of Service being Office.

 (4/20/2021) Tabs > EDITED: All Tabs With Psychological Assessments

• The ellipsis hover menu 'Edit' option, and the double-click on the grid edit had the Smart 
   Functions attached to them updated.
          • When editing a NEW 'ACEs' Assessment record, the software will open the NEW 
             'PopUpACEs' tab.
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Exam > Tabs (EDITED)
          • When editing a NEW 'CSSR' Assessment record, the software will open the NEW 
             'PopUpCSSR' tab.

 (4/28/2021) Tabs > EDITED: Complaint & ComplaintMH

• Left panel
          • Start, End and Total fields
                    • These are the time fields that used to be at the top middle of the tab. They 
                       were moved to the General Information section to be more visible to the 
                       user.
          • Source of Data field
                    • This field was removed, as it is no longer needed.

 (1/21/2021) Tabs > EDITED: Dictation

• Vital Signs panel
          • This is a NEW panel added to the tab. (Request)

 (12/21/2020) Tabs > EDITED: Health Hx2

• Personal Psychiatric and Treatment Hx panel and Family Psychiatric and Treatments Hx 
   panel
          • The ellipsis hover menu option 'Info From Medline Plus' was removed, as it is no 
             longer needed. (Request)

 (4/20/2021) Tabs > EDITED: PopUpAssessList

• Adverse Childhood Experience (ACE) Questionnaire (Request) 
          • This is a NEW TabAdd. When clicked, it will open the NEW 'PopUpACEs' tab.
• AUDIT (Alcohol Use Disorders Identification Test)
          • This is a NEW TabAdd. When clicked, it will open the NEW 'PopUpAudit' tab.
• Columbia-Suicide Severity Rating Scale (C-SSR) Self-Report
          • This is a NEW TabAdd. When clicked, it will open the NEW 'PopUpCSSR' tab.

 (1/21/2021) Tabs > EDITED: PopUpDiagMH & PopUpDiagnosis

• The 'Order' field was moved up to the top, to the left of the 'Code' field. (Request)

 (1/21/2021) Tabs > EDITED: PopUpDocumentsImages

• Date of Document/Image field
          • This is a NEW field that will allow the user to document the actual date on the 
             document that they are importing. (Request) 
          • The 'Doc Date' column was also added to the grid on the 'EHR Documents' tab.
• Image field
          • The size of the field was increased.
• Notes field
          • The size of the field was increased.
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Exam > Tabs (EDITED)
 (4/20/2021) Tabs > EDITED: PopUpIndServicePlan

• Frequency field 
          • The drop-drown table was updated and 'Bi-weekly' was added. (Request)

 (4/28/2021) Tabs > EDITED: PsychologicalAssessments

• Psychological Assessments panel
          • The grid was updated and the 'CSSR' column was added to display the 'Score' for 
             the 'Columbia-Suicide Severity Rating Scale (C-SSR)'.

 (4/28/2021) Tabs > EDITED: See Below

• The following tabs were edited:
          • PopUpFamilyHistory – Family History
          • PopUpHealthHistory – History 
          • PopUpPersonalHistory – Personal History
          • PopUpPersonalTreatmentHx – Personal History
          • PopUpTobaccoUse – Tobacco Use
          • PopUpTreatmentHistory – Family History
• The following NEW fields were added to support 2021 E&M Coding:
          • High Risk check box
          • Historian memo field
• See the following topic for details: 2021 E&M > Universal Exam Field(s) ADDED

 (4/28/2021) Tabs > EDITED: See Below

• The following tabs were edited:
          • PopUpDiagMH – Diagnosis
          • PopUpDiagnosis – Diagnosis
• The following NEW fields were added to support 2021 E&M Coding:
          • Change drop-down field
          • Severity drop-down field
• See the following topic for details: 2021 E&M > Universal Exam Field(s) ADDED

 (4/28/2021) Tabs > EDITED: See Below

• The following tabs were edited:
          • PopUpComplaint – Complaint
          • PopUpSurgery – Surgical History
          • ReviewOfSystems – Review Of Systems
• The following NEW fields were added to support 2021 E&M Coding:
          • Historian memo field
• See the following topic for details: 2021 E&M > Universal Exam Field(s) ADDED

 (2/5/2021) Tabs > EDITED: See Below

• The following tabs were edited:
          • PopUpBIRP – Therapy/Treatment BIRP
          • PopUpBirpT – Therapy/Treatment BIRP
          • PopUpCBT – Cognitive Behavior Therapy
          • PopUpCBTT – Cognitive Behavior Therapy
          • PopUpDAP – Therapy/Treatment DAP
          • PopUpDAPT – Therapy/Treatment DAP
          • PopUpGroup – Therapy/Treatment
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Exam > Tabs (EDITED)
          • PopUpSOAP – Therapy/Treatment SOAP
          • PopUpSOAPT – Therapy/Treatment SOAP
          • PopUpTherapy – Therapy/Treatment
          • PopUpTherapyT – Therapy/Treatment
• The following NEW fields were added to support 2021 E&M Coding:
          • High Risk memo field
          • Historian memo field
• See the following topic for details: 2021 E&M > Universal Exam Field(s) ADDED

 (4/28/2021) Tabs > EDITED: See Below

• The following tabs were edited:
          • HiResDxMHPlan
          • HiResDxPlan
          • HiResPlanImages
          • HiResSess Note 
          • Plan
          • PlanDiagEval
          • PlanMH
          • TMS
• Diagnosis/Plan panel – The Smart Function attached to the 'Quality Measures' option on 
   the ellipsis hover menu was updated. When clicked, the following functionality will occur:
          • Normal tabs
                    • This message displays: Select Yes to use the Quality Measures Claims tab.'
                    • If Yes is selected, it will add the 'Quality Measures Claims 2021' tab to the 
                      end of the layout. 
                    • If no is selected, it will add the 'Quality Measures MIPS 2021' tab to the end
                      of the layout. 
          • HiRes tabs
                    • This message displays: Select Yes to use the Quality Measures Claims tab.'
                    • If Yes is selected, it will add the 'HiResQuality Measures Claims21' tab to the
                      end of the layout. 
                    • If no is selected, it will add the 'HiResQuality Measures MIPS21' tab to the 
                      end of the layout.

 (4/28/2021) Tabs > EDITED: See Below

• The following tabs were edited:
          • PopUpDiagMH – Diagnosis
          • PopUpDiagnosis – Diagnosis
          • PopUpDiagWAxis – Diagnosis
• The following NEW fields were added to support 2021 E&M Coding:
          • Change drop-down field
          • Severity drop-down field
• See the following topic for details: 2021 E&M > Universal Exam Field(s) ADDED

 (4/29/2021) Tabs > EDITED: See Below

• The following tabs were edited:
          • HiResQuality Measures Claims21
          • HiResQuality Measures MIPS21
          • QM Claims 2021 (tablet)
          • Quality Measures Claims 2021
          • Quality Measures MIPS 2021
• Top header
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Exam > Tabs (EDITED)
          • The ellipsis hover menu has the option 'Quality Measure Info'; when clicked, the 
             following web page will open: Quality Measures: Traditional MIPS Requirements.

 (4/28/2021) Tabs > EDITED: TreatPln

• Referrals/Letters panel
          • This is a NEW panel that was added. (Request) 
• Aftercare Program panel
          • This panel was removed, as it is no longer supported on the Compulink-Owned tab.

Exam > Look-up Tables
 (1/13/2021) Look-up Tables > Diagnosis > Name >   Item(s) ADDED

• All new 2021 ICD-10 Codes were added. (Request)

 (12/16/2020) Look-up Tables > Diagnosis > Name >   Item(s) EDITED

• All E08 – E13 Codes were updated, and the Severity of 'Serious' was added.

 (4/28/2021) Look-up Tables > Test > Name >   ADDED: See Below

• The following items were added with 'Type'=Laboratory:
          • Folate, Serum
          • Lithium Level
          • Oxcarbazepine Metabolite

 (12/11/2020) Look-up Tables > Virtual > Historian >   NEW Table ADDED

• A NEW Virtual table called 'Historian' was added.
• This can be accessed by right clicking in the NEW Independent 'Historian' memo field, and
   selecting 'View Lookup List Entries'; this field is found on various tabs.
• This table is not sorted. Enter items in the order you would like them displayed in the 
   table. 
• Add – Add a new record to the bottom of the table
• Complete the fields within the editing window.
          • Display Order – Used to control the position of items in drop-down lists. Enter a 
             number between 1 and 999998. Default is 999999 to display in the order added to
             the table. 
          • Owner – 'C' for Compulink-Owned and 'U' for User-Owned.
          • Hide – This command places you into record <Hide> mode.
                    • Double click on a table entry to toggle Hide from N to Y. This entry will no 
                       longer appear in the table drop-down.
                    • Click Hide again to stop.
          • Value – Enter your Historian Description.
          • Modified – System assigned last date this table entry was accessed.

Inventory
 (1/20/2021) Command (Search) > Default Location

• The Inventory Search window will now default the 'Location' to whatever Location the 
   user has logged into the software with. (Request)

Ledger
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Ledger > Charge Window
 (1/4/2021) Charge Window > Illness Field Default

• The 'Illness' field will default to blank instead of the current date. (Request)
• The Date of Illness is not required, and if submitted, may not be submitted with the same
   date as the Date of Service.
• This is now a Revenue Performance Advisor Requirement.

 (11/3/2020) Charge Window > Units Field Increased

• The width of the '#' or Units field was increased. (Request)

 (11/4/2020) Charge Window > Units Field Trailing Zeros

• The '#' or Units field will no longer display the trailing zeros after the decimal point.
• Example: 1.5 will display, instead of 1.50, and 2 will display, instead of 2.00

 (11/4/2020) Charge Window > Work Comp Marked Y

• If the Primary Payor under the 'Insurance Carriers' defaults to a Payor with 'Type' of 'Work
   Comp', the 'WC?' field will default to 'Y'. (Request)
• If the Primary Payor does NOT default to a Work Comp Payor, but one is selected using 
   the drop-down arrow, the 'WC?' field will automatically change from 'N' to 'Y'. (Request)

Ledger > Commands

Ledger > Command (EHR Post)
 (11/10/2020) Command (EHR Post) > Increased to 14 Days

• The 'EHR Post' command will now look back 14 days (increased from 7) to find Exam 
   Charges that were 'Saved for Ledger Posting'.

Ledger > Command (Print)
 (3/17/2021) Command (Print) > Receipt >   EDITED: See Below

• The last four digits of the patient's credit card will no longer display at the bottom. 
   (Request)

 (1/20/2021) Command (Print) > Report >   EDITED: See Below

• The following items were edited:
          • LedgerStatement_cvv_new
          • LedgerStatement_NEW
• The 'Ext. Note' field will now merge just below each charge line (if an External Note was 
   entered at the Ledger). (Request) 
• The aging buckets at the bottom will reflect the Responsible aging.
          • Current = 0-30
          • Over 30 = 31-60
          • Over 60 = 61-90
          • Over 90 = 91 and up
• Aging messages will merge from the Acct. Billing tab in System Setup. 
          • Utility > System Administrator > System Setup
          • The message that matches the oldest populated greater than zero Responsible 
             aging bucket will merge (oldest balance prints in Over 60 bucket, Over 60 
             message merges).
• Default Statement 
          • The Statements that print from the Ledger via 'Print > Statement', and from 
             'Function > Patient Statements', use the default Statement.
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Ledger > Command (Print)
          • Due to many Advantage Software clients creating custom Statements, we do NOT 
             override the default Statement with software updates.
          • If your practice would like to use one of the Statements above as the default, you 
             must follow the steps below:
                    • Have your Administrator or IT Professional go into your Advantage product 
                       folder and find the file LedgerStatement.LedgerScrnRpt
                    • Rename the file to LedgerStatement.LedgerScrnRptOrig
                    • Find the file LedgerStatement_cvv_new.LedgerScrnRpt or 
                       LedgerStatement_NEW.LedgerScrnRpt (whichever you would like to use) 
                       and rename it to LedgerStatement.LedgerScrnRpt

Look-up Tables

Look-up Tables > EHR
 X (1/12/2021) EHR > Diagnosis > Name > Field(s) ADDED:

• Problem Severity – Used to assign the default Severity to the Diagnosis. 
          • This will default onto the patient record when the Diagnosis is selected, and may 
             be changed at that time. 
          • Options to choose from include the following:
                    • None
                    • Mild
                    • Serious
                    • Urgent/Emergent
                    • Unknown

• Short Search – Enter a User-Owned short description that can be used to search for this 
   Diagnosis in the table. 
          • Click 'Search', use the drop-down to select 'Short Search', enter the User-Owned 
             Short Search and click OK.

 (4/29/2021) EHR > Note > ADDED: See Below

• The following was added for Session Note with a Sort of 'ASSESS':
          • Short Description = PHQ9 - Teens Depression (Request)

 (2/5/2021) EHR > Orders > Definition > ADDED: See Below

• Fiber Supplement
• Light Therapy
• NSAIDS
• Sleep Aids
• Vitamin D
• Multi-Vitamin

 (12/17/2020) EHR > PFSH Legacy Mapping > Responses > ADDED: See Below

• Coronavirus infection – This was added to support the entry on Web Registration.

Look-up Tables > Financial
 X (11/4/2020) Financial > Global Periods > Automatic Table Update

• Access to the 'Global Periods' table was removed from the menu.
• Compulink will be obtaining this information directly from CMS, and automatically adding 
   it to the software upon update; the user will no longer need to manually maintain it.
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Look-up Tables > Financial
 X (1/7/2021) Financial > Services > ADDED: See Below

• The items below were added for NEW INSTALLS only. EXISTING CLIENTS need to add 
   them to the table manually if they will be posting items to the Ledger using the NEW 
   2021 MU tabs.
• All items were added with following in the 'Description' column:
          • Post Code = Match the G code in the Description 
          • Category = QR
          • Cost = 0.00
          • Default values for the rest 
• All items were added with the following in the 'Medicare' fee column:
          • InsCode = Match the G code in the Description 
          • Charge = 0.01
          • Allowed = 999.99
• All items were added with the following in all fee columns OTHER THAN 'Medicare':
          • InsCode = Match the G code in the Description 
          • Charge = 0.00
          • Allowed = 0.00
• Codes to add:
          • #128-G2181 BMI Not Doc Med Rsn
          • #286-G2183 -Pt Doc Cant Comm Info
          • #288-G2184 -Pt No Caregiver
          • #288-G2185-Doc Caregiver Trnd/Cert
          • #288-G2186 Pt/CG Ref App Res/Con
          • #374-G9968-Pt Ref Prov/Spec
          • #431-G2196-Pt Id Unhlthy Alchl User
          • #431-G2197-Pt Not ID Unhlth Alchl
          • #431-G2198-Doc Med Rsn No Scrn
          • #431-G2199-Pt Not Scrnd/No Rsn
          • #431-G2200 - Pt Unhlthy Alchl Brf
          • #431-G2201-Doc Med Rsn No Brf Cnsl
          • #431-G2202 - Pt No Brf Cnsl/Unhlth
          • #431-G2203 - Med Rsn Doc No Brf

Look-up Tables > General
 X (1/13/2021) General > Labs > List >   Field(s) ADDED

• External – A 'Y' identifies this lab as an external lab outside of your practice.
          • This field is used in the NEW 2021 E&M Coding engine.
          • It is VERY important to go through the labs and identify which ones are external.

Patient

Patient > General Changes
 (12/29/2020) Look-up Tables > Primary Language > Item(s) ADDED

• The following items were added to the 'Primary Language' drop-down: (Request)
          • Cantonese/Yue Chinese
          • Mandarin

Patient > Commands
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Patient > Command (Document)
 (11/2/2020) Command (Document) > Requires Review Unchecked

• When Scanning or Importing a document, the 'Requires Review' box will now default to 
   unchecked. (Request)

Patient > Command (Insurance)
 X (12/21/2020) Command (Insurance) > Command (Add) > EDITED: Policy#

• Default – When adding a new Insurance, the 'Policy#' will no longer default to the SSN 
   after selecting the Insured party. (Request)
          • Most Insurance companies no longer use the SSN, so the field will remain blank for
             the user to input the patient's valid Policy# from their card.

• Medicare check – The number of characters check was updated for Medicare. 
          • If an ID with anything other than 11 characters is entered, when the record is 
             saved, the following message will appear: Medicare ID Length requirement is 11!

Patient > Command (Print)
 (4/20/2021) Command (Print) > Audit Report > Patient Recall Added

• Patient Recall Audit information was added to the report. (Request)

 (11/2/2020) Command (Print) > Word Processing > Updated Data Merge 
Assistant

• The 'Data Merge Assistant' window was updated, and the actual database names will no 
   longer display in ( ) to the right of the area of the software.
• Example: 'Patient Demographic (Patient)' will now display as 'Patient Demographic'.

Patient > Command (Search)
 (12/1/2020) Command (Search) > Results Display Updated

• The patient's assigned 'Location' will now display in the results window. (Request)

 (12/1/2020) Command (Search) > Search Filter(s) Added

• The following NEW options were added for filtering the patient Search: (Request)
          • Mid Init. - Patient middle initial
          • Active – Active account (enter 'Y', 'N' or leave blank to ignore the status)

Patient > Command (Utility)
 (1/20/2021) Command (Utility) > Dashboard Update > New Option

• The NEW option 'Dashboard Update' was added.
• This gives the user the option to not wait for the software to automatically update the 
   information on the Provider Dashboard (every 15 min), but manually initiate the update 
   themselves at any time. (Request)

Patient > Layouts & Tabs
 (4/29/2021) Tabs > ADDED: Provider Dashboard (PV)

• This tab was created as a quick view for Providers.
• Contains areas to document/view the following: 
          • Things To Do – Displays the number for each item, and when the user clicks the 
             caption, it will open the corresponding Worklist.
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Patient > Layouts & Tabs
                    • Tests Requiring Review
                    • EHR Docs Requiring Review
                    • Unsigned Med Recs 
                    • Requires Supervisor Signoff
                    • EHR Not Charged/Signed
          • Things To Know – Displays the number for each item, and when the user clicks the
             caption, it will open the corresponding Worklist.
                    • Pending Tests
                    • Pending Erx
          • Pending Tasks – Provider's outstanding Tasks
                    • Single left click on a patient name to be taken to that patient's demographic
                       screen.
          • Appointments – Provider's Appointments for the day
                    • Single left click on a patient name to be taken to that patient's demographic
                       screen.
          • Demographic Provider Dashboard header
                    • To refresh the data, click the ellipsis in the top left corner and select 
                       'Refresh'.

 (1/22/2021) Tabs > EDITED: PopUpDemographics

• Special Needs field – You now have the option to right click in the field to open the 
   'Special Needs' Virtual table to add items. (Request)

Printer & Output Tools
 (11/10/2020) Signature Update > NEW Option ADDED

• The NEW option 'Signature Update' allows the user to save an Electronic Signature.
• When merging documents with the 'Sign' option, the user may add their Electronic 
   Signature to the document.
          • Once the letter is merged and the user selects 'Sign', their Electronic Signature will
             appear on the screen.
          • Drag the Signature to the correct spot, and double click to finalize its location.
          • If the user does NOT want their signature, when it appears, they simply click on 
             the 'Sign' button a second time, and the 'Please Sign' window will appear.
                    • Click 'Clear' to empty the field, and then have the patient sign.
                    • Click 'Accept' and the patient's signature is ready to apply to the document.
• Click the 'Printer & Output Tools' icon on the bottom right of the screen, and select 
   'Signature Update'.
          • A 'Please Sign' window opens with the following options:
                    • Accept – Accept the Signature in the window. 
                              • Click this once the users has electronically signed in the field below.
                              • Click 'OK' on the 'Signature Updated!' message.
                    • Cancel – Cancel/Close the window and do not save the Signature.
                    • Clear – Clear the field below to start over.
                    • Mouse – Default method for collecting the Signature.
                              • Click the drop-down to select from the following Signature Pads:
                                        • ePad (epadlink)
                                        • Topaz (topazsystems)
                                        • Ambir (signotec)
          • Entering and saving an Electronic Signature 
                    • Select the method for collecting the Signature
                    • Sign in the field
                    • Click Accept
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Printer & Output Tools
                    • Click 'OK' on the 'Signature Updated!' message

Reports

Reports > Administrative
 (12/21/2020) Administrative >   EDITED: Time Clock by Week

• Report change:
          • If there is a match between the Login ID and the Login IDs table, the full name 
             from the table will print next to the Login ID; if no match is found, only the ID will 
             print. (Request)

Reports > Appointment
 (1/14/2021) Appointment > Analysis >   EDITED: Utilization

• Report changes:
          • The collection of data was optimized, and therefor, the report will now run much 
             faster than the previous version. (Request) 
          • Now contains two distinct percentages:
                    • Utilization – Patient Appointments versus Unblocked Slots
                    • Usage – (Blocks and/+ Patient Appointments) versus All Slots

Reports > Electronic Health Record
 (1/20/2021) Electronic Health Record > MEANINGFUL USE >   EDITED: See Below

• The following reports were edited:
          • MU Objectives 2015 Stages 1-2
          • MU Objectives 2015 Stage 3
• The information regarding the data in the Report has been updated to inform the user 
   that the report is HISTORICAL ONLY. (Request)
• It also displays the path in the Advantage Online Help file where the Historical help 
   information can be found for the report.

 (1/20/2021) Electronic Health Record > MEANINGFUL USE >   EDITED: See Below

• The following reports were edited:
          • CQM Totals Only (2014-2021)
                    • Title bar – The year was extended and will now display 2014-2021.
          • Quality Reporting Category 1
                    • Detail – Field references were updated to match the Exam table updates.
          • Quality Measures Category 3
                    • Detail – Field references were updated to match the Exam table updates.
• ONC 2014 references were removed from all 3 reports. (Request)

Reports > System Admin.
 (4/22/2021) System Admin. > PracticeWatch Setup

• Patient Recall Audit information was added to the report. (Request)

Utility
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Utility > Exam E/M Code Level Logic
 X (12/14/2020) Exam E/M Code Level Logic >   Utility Moved to Patient Exam Utility

• The 'Exam E/M Code Level Logic > Logic Pages' and 'Logic Sets' have been moved under 
   the 'Utility' command in the patient Exam for easier access when making changes.
• User will only have access to this if Login Rights Profile 'EHR Coding Logic' is set to Full.
• Under 'Utility', select 'Coding Logic' to open what used to be 'Logic Sets'.
• Once inside 'Coding Logic', click on 'Components' at the top to open what used to be 
   'Logic Pages'.

Utility > PracticeWatch Setup
 X (12/10/2020) PracticeWatch Setup >   Multi-Threading

• Multi-threading will allow the majority of tasks to run on their own thread, such that a 
   frozen task or task that can take many hours, does not hold up the other processes from 
   running. 
• This change is handled through the DLL that is delivered through a normal update; there 
   is no need to reinstall the service.
• Important item to be aware of:
          • If your practice has numerous tasks set up to run at the same time, you can 
             expect PracticeWatch to use more processing power, now that they run parallel, 
             instead of one waiting on the next to complete.

Utility > System Administrator
 X (1/20/2021) System Administrator > Login > Profiles >   Right(s) Renamed

• EHR Posting Logic – Renamed to 'EHR Coding Logic' to coincide with the moving and 
   renaming of the tables.

• Patient Follow-Up/Todo – Renamed to 'Patient Follow-up/Todo/Tasks'.
          • This Right will now control Access Rights to Patient Tasks.

• Patient Insurance – Renamed to 'Patient Insurance/Episode Data'.
          • This Right will now control Access Rights to Episode Data.

 (12/18/2020) System Administrator > System Setup > Acct. Billing Tab > 
Field(s) ADDED

• Statement section – Fields added for NEW PracticeWatch Auto-Collection function.
          • Auto Collection Charge Days
                    • The number of days old a charge (with a balance) must be, before it 
                       becomes eligible for the Auto-Collection function.
                    • Default is set to '0', meaning Not in Operation.
          • Auto Collection Last Payment Days
                    • The number of days since the last Responsible payment was made on the 
                       charge, before it is eligible for the Auto-Collection function.
                    • Default is set to '0', meaning Not in Operation.

 X (11/4/2020) System Administrator > System Setup > Miscellaneous Tab > 
Field(s) ADDED

• Miscellaneous section
          • Prevent Doc. Merge Edits – Option to allow/prevent users from editing SINGLE 
             documents after they merge patient data to the screen, and prior to 
             printing/saving the document.
                    • Default is set to blank or 'False', ALLOWING the users to edit the documents
                       AFTER they have been merged.
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Utility > System Administrator
                    • Click the box to enter a check or 'True' value to PREVENT the users from 
                       editing the documents AFTER they have been merged.
                              • When the letter is selected, it will bypass the merge screen, and go 
                                 directly to the printer.
                              • If a 'Sign' version of letter is selected, it will bypass the merge 
                                 screen, and open directly to the Sign screen.
                    • As with any change to the System Setup, you must restart the application 
                       for changes to take effect.

Worklists

Worklists > General Changes
 (1/20/2021) General Changes > PopUpLayout Alignment

• If selecting a record on the Worklist takes you to a patient and opens a PopUpLayout for 
   editing, that PopUpLayout will now open at the top left of the screen, so as not to 
   interfere with any Worklists that may be open on the right side of the screen.

 (1/14/2021) General Changes > Right Side Alignment

• Worklists will now open at a specified distance from the right side of the monitor; this was
   done to handle users that have 2 monitors.

 (1/14/2021) General Changes > Worklist Minimized

• When going through items on a Worklist, the Worklist itself will automatically minimize in 
   the following situations:
          • Double click a line on the Worklist that takes you to a patient Exam and opens a 
             PopUpLayout for editing.
          • Double click a line on the Worklist that takes you to a patient Ledger and opens a 
             Ledger Detail line for editing.
          • Double click a line on the Worklist that takes you to a patient Task and opens that 
             Task for editing.
• After saving each edit window above, the Worklist will automatically maximize to allow 
   you to keep working.
• This change was added to reduce the clutter on the screen when edits are being made.

Worklists > Global
 (1/20/2021) Global > EHR Documents Requiring Review

• The SQL Script was updated for the following items:
          • It will now display all records from the NEW Imagereview table.
          • When selecting a record, it will go to the patient Exam and open the appropriate 
             sub-table record.
• An 'Area' column was added to the display to show where the record is stored.
          • EHR Communications (ExamCommunication)
          • EHR Images (ExamImage)
          • EHR Surgeries (ExamSurg)
          • EHR Testing (ExamTest)
          • EHR Treatments (ExamTreatment)
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